
Priebeh numerického modelovania pomocou softvérového systému 
ANSYS. 
CFD program ANSYS Fluent je súčasťou programového balíka ANSYS Academic Research CFD 
dostupného na FBERG TUKE. Pracovné prostredie programového balíka sa nazýva ANSYS WORKBENCH 
(WB). V tomto programe je možné vytvárať strom simulácie a väzby medzi jednotlivými krokmi 
samotnej simulácie. Je možné tiež vytvárať väzby medzi jednotlivými variantami a  modifikáciami. 
Program zaisťuje prehľadné simulácie, pričom užívateľ môže spúšťať jednotlivé programy v tomto 
prostredí, bez toho aby musel  hľadať súbory prostredníctvom súborového manažéra. Užívateľské 
prostredie ANSYS Workbench je znázornené na nasledujúcom obrázku.  

 

Filozofia spočíva vo vytvorení projektu, ktorý bude v sebe obsahovať všetky fázy (pre-processing, 
processing a post-processing). Takto vytvorený projekt bude ukladaný v tvare („Workbench Project 
Files - *.wbpj“). Užívateľské prostredie ANSYS Workbench sa skladá z štyroch oblastí – Roletové menu, 
Nástroje programu ANSYS, Prostredie znázorňujúce štruktúru projektu.  

Roletové menu obsahuje funkcie pre prácu so súbormi (vytvorenie projektu, načítanie projektu, 
ukladanie projektu, aktualizácia projektu ...). Zároveň je možné si definovať jednotky a prispôsobiť 
užívateľské prostredie ANSYS Workbench.  

Prostredie znázorňujúce štruktúru projektu predstavuje pracovnú plochu, v  ktorej si užívateľ vytvorí 
potrebnú štruktúru jednotlivých programov, ktoré bude v priebehu tvorby projektu využívať.  



Informačný panel poskytuje užívateľovi informácie o realizovaných operáciách v prostredí Workbench. 
Informačný panel taktiež poskytuje užívateľovi chybové resp. informatívne hlásenia.  

Nástroje programu ANSYS obsahujú produkty, ktoré sú v rámci softvéru ANSYS k dispozícii. Množstvo 
produktov závisí od toho pre ktoré má užívateľ licenciu. Prácu začíname po spustení ANSYS Workbench 
dvojklikom v Nástrojoch programu ANSYS Fluid Flow (Fluent). Otvorí sa nám nasledovná tabuľka.  

 

Dvojklikom na Geometry sa otvorí program Design Modeler (DM). Tento program slúži 
k parametrickému kresleniu 3D. V programe je možné kresliť podobným spôsobom ako pri iných CAD 
programoch, napr. ProEngineer, Catia. Z týchto programov je možné načítať hotové 3D modely do DM. 
Geometrické dáta sú z externých preprocesorov vkladané do DM transportom. Súčasné normované 
rozhrania medzi CAD programami sú IGES, DXF, VDA-FS, STEP, STL. Transportované 3D objekty je 
možné zjednodušiť a odstrániť prebytočné entity. Výpočtová oblasť je upravená a modifikovaná 
vhodným spôsobom pre CFD simulácie.  

Dvojklikom na Mesh sa spustí program Meshing. Slúži na priestorovú diskretizáciu a teda vytvorenie 
siete. Tvorba siete je relatívne jednoduchá. V programe sú implementované všetky základné typy 
elementov a je možné vytvárať štruktúrovanú aj neštruktúrovanú, zonálnu alebo hybridnú sieť. 
Program obsahuje aj funkcie na posúdenie kvality vytvorenej siete.  

Ďalšie bunky Setup, Solution a Results slúžia na pracovanie s programom ANSYS Fluent. Samotné 
simulácie je možné vo Fluente realizovať aj osobitne a spúšťať ho z prostredia Windows.  

Predkladaný učebný text si nekladie za cieľ nahrádzať „User Guide“ k softvéru ANSYS, preto definícia 
jednotlivých príkazov a nástrojov bude ukázaná a aplikovaná v prípadových štúdiách.   

 

Simulácia prúdenia v kanále s náhlym rozšírením 2D 
V tejto kapitole si na jednoduchom príklade predvedieme základný postup pri tvorbe numerickej 
simulácie prúdenia. Celý postup si budeme ilustrovať na 2D úlohe. Cieľom bude vizualizácia prúdového 
poľa a sledovanie zavírenia v rozširujúcej sa časti obdĺžnikového kanálu. Ide o veľký rozmerný kanál, 
v ktorom prúdi tekutina. Tekutina vstupuje do oblasti ľavou užšou stranou a  vystupuje pravou širšou.  

 

Schematický náčrt výpočtovej oblasti. 

 

Spustíme ANSYS Workbench. Dvojklikom na Fluid Flow (Fluent) sa v pracovnom prostredí WB zobrazí 
už uvedená tabuľka. Dvojklikom na Geometry sa spustí DM. Program sa môže pýtať na jednotky. 
Vyberieme milimetre. Ak nám túto možnosť nedáva, ideme do roletového menu Unit a zaškrtneme 
milimetre. 



 

Grafické rozhranie Design Modeler 

 

Kreslenie začneme tvorbou skice (sketch) ktorá bude reprezentovať tvar výpočtovej oblasti. Vyberieme 
si 1. XYPlane, 2. kolmý pohľad na rovinu, 3. Novú skicu (New sketch) 

 

Prepneme sa na záložku Sketching, kde sa otvoria nástroje pre 2D kreslenie. V menu kreslenia 
vyberieme príkaz priamka Line.  

 

 

V priebehu kreslenia sa nezadávajú rozmery, ale najprv sa vytvorí obrazec geometricky podobný tomu, 
ktorý chceme nakresliť, ten sa zakótuje a následne sa upravia rozmery kót podľa zadania. Automaticky 
je zapnutý režim automatického uchopenia a viazania entít. Význam veľkých písmen vedľa kurzoru je 
nasledovný. 



P – uchopenie bodu (point) 

H – vodorovná priamka (horizontal) 

V – zvislá priamka (vertical) 

C – totožnosť  

 

Obrysové body začneme kresliť z bodu (0,0) v smere hodinových ručičiek. Naznačené poradie kreslenia 
je uvedené na nasledovnom obrázku.  

 

Označenie priamok a poradie kreslenia priamok 

 

Postup kreslenia: 

1. Kurzor umiestnime do blízkosti stredu súradnicového systému tak, aby sa objavilo písmeno P. 
Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor posunieme nahor (cca 3 cm na obrazovke) 
tak, aby sa pri priamke objavilo písmeno V. Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. 

 

 

 

 

   
Grafické zobrazenie vytvárania priamky č.1 

 

2. Kurzor umiestnime do blízkosti koncového bodu priamky č.1 tak, aby sa objavilo písmeno P. 
Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor posunieme doľava (cca 5 cm na obrazovke) 
tak, aby sa pri priamke objavilo písmeno H. Kliknutím na ľavé tlačidlo myši potvrdíme voľbu.   

   
Grafické zobrazenie vytvárania priamky č.2 



 

3. Opakujeme postup ako v prípade priamky č.1. Kurzor umiestnime do blízkosti koncového bodu 
priamky č.2 tak, aby sa objavilo písmeno P. Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor 
posunieme nahor (cca 2 cm na obrazovke) tak, aby sa pri priamke ob javilo písmeno V. Kliknutím na 
ľavé tlačidlo myši potvrdíme voľbu. 

4. Kurzor umiestnime do blízkosti koncového bodu priamky č.3 tak, aby sa objavilo písmeno P. 
Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor posunieme doprava (cca 15 cm na 
obrazovke) tak, aby sa pri priamke objavilo písmeno H. Kliknutím na ľavé tlačidlo myši potvrdíme 
voľbu.  

5. Kurzor umiestnime do blízkosti koncového bodu priamky č.4 tak, aby sa objavilo písmeno P. 
Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor posunieme dole k osi x tak, aby sa pri 
priamke objavilo písmeno V a pri koncovom bode na osi x písmeno C. Kliknutím na ľavé tlačidlo myši 
potvrdíme voľbu.  

6. Kurzor umiestnime do blízkosti koncového bodu priamky č.5 tak, aby sa objavilo písmeno P. 
Kliknutím na ľavé tlačidlo myši potvrdíme voľbu. Kurzor posunieme doprava k počiatku 
súradnicového systému tak, aby sa pri priamke objavilo písmeno V a pri koncovom bode písmeno 
C. Kliknutím na ľavé tlačidlo myši potvrdíme voľbu.   

 
Znázornenie skice 

 

Výsledný obrys výpočtovej oblasti by mal vyzerať tak ako je na obrázku. 

Prepneme sa zo záložky Draw do záložky Dimensions. Pristúpime ku kótovaniu škice. Kótovanie slúži 
k zadefinovaniu rozmerov nakresleného obrazca. Kótovanie začneme horizontálnymi kótami. 
V Dimensions menu vyberieme kóty Horizontal.  

 
Panel kótovania 

 

Postup kótovania je podobný s postupom kreslenia: 

1. Kurzor umiestnime do blízkosti priamky č.1 tak, aby priamka zmenila farbu z  modrozelenej na 
oranžovú. Ľavým tlačidlom potvrdíme voľbu. Priamka zmení farbu na žltú, čo znamená že je vybraná 
(aktívna). Kurzor posunieme k priamke č.3 tak, aby priamka opäť zmenila farbu na oranžovú. Voľbu 



potvrdíme ľavým tlačidlom. Teraz by sa mala naznačiť horizontálna kóta, pohybom kurzoru (nahor 
alebo nadol) je možné umiestniť kótu do ľubovoľnej pozície. Umiestnenie kóty potvrdíme ľavým 
tlačidlom. Po umiestnení by sa mala zobraziť kóta označená H1.  

 
Horizontálna kóta H1 

 

2. Rovnakým spôsobom zakótujeme rozmer medzi priamkami č. 3 a  č.5.  

3. Po vytvorení horizontálnej kóty H2 zmeníme typ kóty z horizontálnej na vertikálnu. Zakótujeme 
celkovú výšku medzi priamkami č.4 a č.6, kótu V3. 

4. Následne zakótujeme výšku zúženej časti, tj. výšku medzi priamkami č.2 a  č.4, kótu V4. Po 
umiestnení kót mení obrys farbu z modrozelenej na sýtomodrú, čím program signalizuje kompletné 
zakótovanie obrysu, tj. obrys je jednoznačne definovaný. Zakótovaná škica by mala vyzerať 
nasledovne. 

 
Kompletné zakótovanie 

 

V prípade, že by sme omylom zakótovali 2x tú istú kótu, alebo zakótovali napr. horizontálnu kótu medzi 
priamkami č.1 a č.5. tak škica bude predimenzovaná a obrys škice zmení farbu na červenú. Duplicitnú 
(chybnú) kótu je potrebné odstrániť. 



 
Predimenzované zakótovanie 

 

V ľavej dolnej časti obrazovky je zobrazená tabuľka s vlastnosťami danej entity (Details View), v našom 
prípade sú to informácie o škici č.1. V tejto tabuľke zmeníme rozmery podľa zadania. 

 
Detail položky Sketch1 

 

Kótu číselne prepíšeme tak, že ľavým tlačidlom klikneme na číslo a  následne ho prepíšeme. Kliknutím 
na inú položku tabuľky, alebo stlačením klávesy Enter sa zmena aplikuje. Takto zmeníme hodnoty 
všetkých kót. Keďže sa zmena aplikuje priebežne, tak sa nám naša škica deformuje a  po zadaní 
posledného rozmeru by mala vyzerať nasledovne. 

 
Finálna škica 

 

Pomocou nástroja Move v paneli kótovania Dimensions je možno posúvať kóty. 

 

Vytvorenie priestoru prúdenia 
Po nakreslení škice a zakótovaní rozmerov pristúpime k vytvoreniu priestoru prúdenia 2D. Zatiaľ máme 
len škicu ktorá nám tento priestor prúdenia bude ohraničovať. Samotný priestor prúdenia je 
definovaný plochou. Prepneme sa zo záložky Sketching na záložku Modeling. Z Menu vyberieme 
Concept, Surfaces From Sketches.   



 
Výber 

 

V okne Details View ľavým tlačidlom klikneme na žltým podsvietené Not selected pri Base Objects.  

  
  

 

Objavia sa tlačidlá Apply a Cancel. V ľavom hornom okne so stromom geometrických entít vyberieme 
Sketch1. Výberom škica zmení farbu na žltú. V tabuľke Details View stlačíme tlačidlo Apply. Farba škice 
sa zmení na tyrkysovú. V stromovom okne sa objaví položka SurfaceSk1 s bleskom. 

 
 

 

To že ešte príkaz nebol zrealizovaný symbolizuje práve žltý blesk. Realizáciu príkazu vykonáme 
stlačením tlačidla Generate so symbolom blesku. Vytvorená plocha v škici má šedú farbu. 



 
 

 

Týmto krokom je ukončená tvorba geometrie. Vytvorenú geometriu uložíme Save a ukončíme Design 
Modeler. V prostredím Workbench je možné si všimnúť, že po vytvorení geometrie, ktorá neobsahuje 
žiadnu chybu, sa objaví zelené odškrtnutie.  

 
Zmena položky Geometry po vytvorení geometrie.   

 

Vytvorenie siete 
Vytvorenie siete je ďalším z krokov pri simulácií prúdenia. Kvalita siete je jedným z podstatných 
parametrov, ktoré ovplyvňuje výsledky výpočtov. Tvorbu siete zahájime dvojklikom na položku Mesh. 
Týmto príkazom sa automaticky načíta  vytvorená geometria a spustí sa program Meshing. Grafické 
rozhranie je podobné programu Design Modeler a princíp ovládania rovnaký. Vľavo hore je stromová 
štruktúra. Vľavo dole tabuľka s nastaveniami.  

Vytvoríme si jednoduchú neštruktúrovanú sieť.  V okne Outline klikneme na Mesh, vyvoláme 
kontextovú ponuku, vyberieme Insert>Sizing. Klikneme na teleso kanála, zmení sa jeho farba na zelenú. 
(Pozn. V prípade že teleso nie je možné vybrať, je potrebné najprv kliknúť na ikonu Face  
(CTRL+F) a potom na teleso kanála). Klikneme na žltým podsvietené No Selection, pri okne Geometry v 
Details of “Body Sizing” – Sizing, stlačíme Apply. Teleso kanála zmení farbu na modrú. Nastavíme 
hustotu siete v Element Size,  napr. na 0,01 m. Klikneme na Generate. Teraz ak klikneme v okne Outline 
na Mesh zobrazí sa vytvorená výpočtová sieť.  

 
 

 

 Pre lepšiu orientáciu a definovanie okrajových podmienok pomenujeme (označíme) jednotlivé plochy 
geometrie. Vzhľadom k tomu, že máme obrázok 2D budeme označovať hrany. 



 
Označenie plôch 

 

Postup je nasledovný. Vo výberovom menu zvolíme položku Edge. Priblížime sa kurzorom k ľavej 
vertikálnej priamke č.3, ktorá bude reprezentovať miesto vstupu tekutiny. Hrana zmení farbu na 
červenú. Voľbu potvrdíme ľavým tlačidlom, zmení sa farba hrany na zelenú a  pravým tlačidlom 
vyvoláme kontextovú ponuku a zvolíme položku Create Named Selection. Následne sa objaví okno, 
ktoré slúži k voľbe pomenovania. Vybranú plochu (hranu) pomenujeme Inlet a voľbu potvrdíme OK. 
V stromovej štruktúre vľavo sa objaví položka Named Selections, ktorá predstavuje pomenované 
plochy (hrany). Vyberiem zadnú hranu a rovnakým postupom ju označíme ako outlet. Obdobným 
spôsobom pomenujeme (ostatné) plochy (hrany). Pomenovanie (označenie) plôch (hrán) je možné 
vytvoriť aj pre zoskupenie plôch (hrán), ktoré budú mať rovnaké fyzikálne parametre.  Plochu, alebo 
hranu ktorá nebude označená bude CFD program považovať za stenu. Pomenovanie plôch (hrán) môže 
byť ľubovoľné bez diakritiky. 

 
Označenie plochy (hrany) 

 

Sieť máme vytvorenú a sme pripravený na nastavenie a spustenie simulácií. V tejto chvíli máme na 
výber či sa vrátime do ANSYS Workbench a dvojklikom na Setup (predtým je potrebné kliknúť na 
Update Project), alebo vyexportovať súbor *.msh a načítať ho do programu ANSYS Fluent. Na základe 
skúseností odporúčam druhu možnosť a to v programe Meshing, vyberieme z roletového menu 
File>Export. Súbor si ľubovoľne pomenujeme ale uložíme ho ako typ: FLUENT Input Files (*.msh). 
 

Nastavenie a spustenie simulácie 
Otvoríme si program ANSYS Fluent. V otváracom okne označíme Dimension – 2D  a pri Options – Double 
Precision. 

 



 

 
Z roletového menu vyberáme príkaz File>Read>Mesh a načítame vytvorený súbor. 
 

 
 

 
Nastavíme teraz simuláciu. Klikneme na General pod Solution Setup. Tu ponecháme všetky nastavenia 
ako sú. Solver (riešič) bude Pressure Based. Budeme riešiť stacionárnu úlohu s absolútnou formuláciou 
rýchlosti. 2D priestor je Planar (rovinný).  

 
 

 
Nastavíme sa na Models a dvojklikom na Viscous sa nám zobrazia modely prúdenia. Vyberieme si 
model k-omega a v poli k-omega Model vyberieme Standard. Odklikneme OK.  

  
  

 
Nastavíme sa na Materials. Vzhľadom k tomu, že je ako Fluid prednastavený vzduch (Air) a my chceme 
vodu, klikneme na tlačidlo Create/Edit a otvorí sa okno Create/Edit Materials. Klikneme na tlačidlo 



Fluent Database a v roletovom okne vyberieme water-liquid. Klikneme na tlačidlo Copy. Týmto 
úkonom sme nakopírovali vodu a jej fyzikálne vlastnosti medzi tekutiny s ktorými môže program 
pracovať. Odklikneme Close, Close. Klikneme na Cell Zone Conditions. Teraz nastavíme to, aby program 
bude pracoval s vodou ako prúdiacim médiom. Doteraz ešte stále je nastavený vzduch. Klikne na Edit...  
a otvorí sa okno Fluid. Vidíme že v okne Material Name je air a z roletového menu vyberieme water-
liquid. Potvrdíme voľbu OK.  
Kliknutím na Boundary Conditions sa nám v okne Zone zobrazia okrajové podmienky, ktoré sme 
definovali v ešte v programe Meshing. Je vhodné skontrolovať či pod Type je vysvietená požadovaná 
okrajová podmienka. Ak to tak nie je, tak je to tu potrebné zmeniť, kliknutím a  vybratím správnej. Čiže 
inlet – velocity inlet, outlet – pressure outlet, wall-surface body – wall. Okrem definovaných okrajových 
podmienok sa nám objavili ďalšia okrajová podmienka, ktorá vyjadruje interiér, čiže vnútro priestoru 
prúdenia a nijakým spôsobom neovplyvňuje prúdenie.  

  
 

Klikneme na inlet a stlačíme Edit....  Otvorí sa okno Velocity Inlet. V tejto úlohe budem pracovať len 
s možnosťami na záložke Momentum. Klikneme na roletové menu pri Velocity Specification Method 
a ponecháme Magnitude, Normal to Boundary. To znamená, že stanovíme rýchlosť a smer prúdenia 
bude kolmo vychádzajúci z velocity inlet. Do okna Velocity Magnitude (m/s) napíšeme 3. 
Supersonic/Initial Gauge Pressure (pascal) sa nás netýka, pretože neriešime stlačiteľnosť. V sekcii 
Turbulence je ešte potrebné nastaviť Specification Method. Klikneme na rolovacie menu a vyberieme 
Intensity and Hydraulic Diameter. Intenzitu turbulencie pri modelovaní prúdenia v potrubí môžeme 
ponechať 5%. Hydraulic diameter (hydraulický priemer) pri 2D simuláciách, je rovný šírke domény, 
resp. šírke vstupu čo je u nás 0,3 m. (Pozn. Fluent vyžaduje desatinnú čiarku v tvare bodky.) Okrajovú 
podmienku rýchlostného vstupu máme nastavenú, klikneme tlačidlo OK.  
Klikneme na outlet a stlačíme Edit....  V sekcii Turbulence je takisto potrebné nastaviť Specification 
Method. Klikneme na rolovacie menu a vyberieme Intensity and Hydraulic Diameter.  
Zadáme hodnoty: Backflow Turbulent Intensity 5% a Backflow Hydraulic diameter 0,5 m. OK.  
Položku Dynamic Mesh nebudeme nastavovať, pretože nepracujeme s pohyblivou alebo deformujúcou 
sa sieťou.  
Klikneme na Reference Values. Tu nepotrebujeme nič meniť. 
Pod Solution klikneme na Solution Methods. Nastavenia urobíme podľa obrázku XXX. Pressure Velocity 
Coupling: Scheme – SIMPLE, Spatial Discretization: Gradient – Least Squares Cell Based, Pressure – 
Second Order, Momentum – Second Order Upwind, Turbulent Kinetic Energy – Second Order Upwind, 
Specific Dissipation Rate – Second Order Upwind.  



 
 

 
Na položke Solution Controls nenastavujeme nič. Klikneme na Monitors, nastavíme sa v okne Residuals, 
Statistic and Force Monitors na Residuals – Print, Plot a klikneme na tlačidlo Edit.  Otvorí sa okno 
Residuals Monitor, kde ponecháme zaškrtnuté Print to Console a Plot a v rolovacom okne Convergence 
Criterion nastavíme none. Síce sa udáva, že pri hodnotách rezíduí pod 0,001 sú výsledky konvergované, 
ale osobná skúsenosť ukazuje, že je potrebné sledovať, kedy sa ustália sily pôsobiace na objekt. Z toho 
dôvodu sme nezadali konvergenčné kritériá,  pri ktorých by sa výpočet prerušil. Pokračujeme kliknutím 
na tlačidlo OK.  
Nastavíme sa na Solution Initialization a klikneme na tlačidlo Initialize. Týmto sa nám simulácia 
inicializuje. Ďalšiu položku Calculation Activities preskočíme, pretože nebudeme nastavovať 
automatické ukladanie. Ostáva len spustenie simulácie a to tak, že klikneme na položku Run Calculation 
a v okne Number of Iterations nastavíme predpokladaný počet iterácií. Napíšeme 1500 a klikneme na 
tlačidlo Calculate.  Po ukončení výpočtu sa pozrime na priebeh iterácií. Mali by sme mať nasledovné 
výsledky. 
 

 
 

 

Zobrazíme si distribúciu rýchlosti pomocou izoplôch. Pod položkou Results sa nastavíme na Graphics 
and Animations a v okne Graphics na Contours, Set Up...  Zaškrtneme  



Filled a v položke Contours of ponecháme Velocity a Velocity Magnitude. Klikneme na tlačidlo Display. 
Zobrazí sa nasledovný obrázok.  

 
 

V prípade, že chceme jemnejšie prechody farieb, v okne Levels nastavíme vyššiu hodnotu ako 20, 
maximálne 100. Nevýhodou Velocity Magnitude je, že je to rýchlosť zobrazovaná v každom bode  
ale nevieme z nej určiť smer prúdenia. Obdobným spôsobom si preto zobrazíme priebehy x-rýchlosti. 
V položke Contours of vyberieme z roletového menu Velocity... a pod tým X Velocity. 

 
 

 
Z uvedeného obrázka je už možné vidieť že za schodom je tzv. spätné prúdenie zobrazované modrou 
farbou s maximom rýchlosti do -0,365 m/s.  
Ďalej si zobrazíme vektory prúdenia. Pod položkou Results sa nastavíme na Graphics and Animations a 
v okne Graphics na Vectors, Set Up... , Display.  Po priblížení dostaneme nasledovný obrázok. Simuláciu 
si uložíme File>Write>Case&Data. 

 
 



 

A na záver si zobrazíme priebeh rýchlosti na výstupe a  vypočítame výslednú rýchlosť. Pod položkou 
Results sa nastavíme na Plots a v okne Plots na XY Plot, Set Up…. Otvorí sa okno Solution XY Plot.  V 
okne Surfaces máme označíme outlet. Vyškrtneme Position on X Axis a zaškrtneme Position on Y Axis.  
V Plot Direction máme v okne X 0 a v okne Y 1. V roletovom menu Y Axis Function si pod Velocity 
vyberieme X Velocity.  
 
 

 
 

Zobrazí sa nasledovný priebeh – rýchlostný profil.  

 
 

 
Rýchlosť prúdenia je v spodnej časti kanála vplyvom rozšírenia nižšia. Priemernú rýchlosť na výstupe 
zistíme tak, že klikneme na Reports pod Results. Z okna Reports vyberieme Surface Integrals>Set Up…. 
V roletovom menu Report Type vyberieme Area-Weighted Average. Vo Field Variable vyberieme 
Velocity. V okne Surfaces vyberieme outlet. Klikneme na tlačidlo Compute a vidíme že rýchlosť na 
výstupe je 0,9 m/s, čo sme mohli vypočítať aj z rovnice kontinuity. 
 

Simulácia prúdenia v kanále s náhlym rozšírením 3D 
Rozšírime si predchádzajúcu úlohu o tretí rozmer, čiže budeme riešiť simuláciu prúdenia 3D.  

Vytvorenie geometrie 
Vytvoríme 2D geometriu kanálu podľa návodu uvedeného v predchádzajúcej kapitole. V okne Tree 
Outline pod XY Plane klikneme na Sketch, čiže vytvorenú škicu kanála. Klikneme na tlačidlo Extrude, čo 
znamená vystrčiť, resp. vysunúť škicu a tým vytvoriť objem. V okne Details View pri Geometry klikneme 



na Apply. Pri okne Direction klikneme na Normal a z roletového menu vyberieme Both – Symmetric. 
Do okna pri FD1 Depth napíšeme 750, to znamená že skicu vysuniete oboma smermi a kanál bude 
široký 1,5 m. Generate.  Mali by sme mať nasledovný obrázok.  

 
 

 

Ak nám z predošlej 2D úlohy ostalo v Tree Outline aj Surface Body (plocha 2D kanála) je potrebné ho 
vymazať (Create>Delete>Body Delete vybrať Surface Body kliknúť Apply>Generate) alebo ho označiť, 
vyvolať kontextovú ponuku a vybrať Suppress Body. 

 
 

 

Vytvorenie siete 
Sieť vytvoríme obdobným spôsobom ako v predchádzajúcej úlohe. Dvojklik na položku Mesh. Načíta 
sa vytvorená geometria a spustí sa program Meshing. V okne Outline klikneme na Mesh, vyvoláme 
kontextovú ponuku, vyberieme Insert>Sizing. Klikneme na teleso kanála, zmení sa jeho farba na zelenú. 
(Pozn. V prípade že teleso nie je možné vybrať, je potrebné najprv kliknúť na ikonu Body/Element  
(CTRL+B) a potom na teleso kanála). Klikneme na žltým podsvietené No Selection, pri okne Geometry 
v Details of “Body Sizing” – Sizing, stlačíme Apply. Teleso kanála zmení farbu na modrú. Nastavíme 
hustotu siete v Element Size,  napr. na 0,03 m. Klikneme na Generate. Teraz ak klikneme v okne Outline 
na Mesh zobrazí sa vytvorená výpočtová sieť.  

Nasleduje  zadefinovanie okrajových podmienok, čiže pomenujeme (označíme) jednotlivé plochy 
geometrie. Vzhľadom k tomu, že máme obrázok 3D budeme označovať plochy. Vo výberovom menu 
zvolíme položku Face (CTRL+F). Klikneme na plochu, ktorá bude reprezentovať miesto vstupu tekutiny. 
Plocha zmení farbu na zelenú a pravým tlačidlom vyvoláme kontextovú ponuku a  zvolíme položku 
Create Named Selection. Následne sa objaví okno, ktoré slúži k voľbe pomenovania. Vybranú plochu 
(hranu) pomenujeme Inlet a voľbu potvrdíme OK. V stromovej štruktúre vľavo sa objaví položka Named 
Selections, ktorá predstavuje pomenované plochy (hrany). Vyberieme plochu ktorou tekutina bude 
opúšťať kanál a nazveme ju Outlet.  



  

  

 

Obdobným spôsobom pomenujeme (ostatné) plochy (hrany). Pomenovanie (označenie) plôch (hrán) 
je možné vytvoriť aj pre zoskupenie plôch (hrán), ktoré budú mať rovnaké fyzikálne parametre. Plochu, 
alebo hranu ktorá nebude označená, bude CFD program považovať za stenu. Pomenovanie plôch 
(hrán) môže byť ľubovoľné bez diakritiky. Vyexportujeme sieť. Vyberieme z roletového menu 
File>Export. Súbor si ľubovoľne pomenujeme a uložíme ho ako typ: FLUENT Input Files (*.msh). 

Nastavenie a spustenie simulácie 
Otvoríme si program ANSYS Fluent. V otváracom okne označíme Dimension – 3D  a pri Options – Double 
Precision. OK. Z roletového menu vyberáme príkaz File>Read>Mesh a načítame vytvorený súbor. 
Klikneme na General pod Solution Setup. Tu ponecháme všetky nastavenia ako sú. Solver (riešič) bude 
Pressure Based. Budeme riešiť stacionárnu úlohu s absolútnou formuláciou rýchlosti.   
Nastavíme sa na Models a dvojklikom na Viscous sa zobrazia modely prúdenia. Vyberáme model k-
omega a v poli k-omega Model vyberieme Standard. Odklikneme OK.  
Nastavíme sa na Materials. Vzhľadom k tomu, že je ako Fluid prednastavený vzduch (Air), pridáme 
vodu. Klikneme na tlačidlo Create/Edit a otvorí sa okno Create/Edit Materials. Klikneme na tlačidlo 
Fluent Database a v roletovom okne vyberieme water-liquid. Klikneme na tlačidlo Copy. Odklikneme 
Close, Close. Klikneme na Cell Zone Conditions. Klikneme na Edit...  a otvorí sa okno Fluid. Z roletového 
menu vyberieme water-liquid. Potvrdíme voľbu OK.  
Kliknutím na Boundary Conditions sa v okne Zone zobrazia okrajové podmienky, ktoré sme definovali 
v ešte v programe Meshing. Je vhodné skontrolovať či pod Type je vysvietená požadovaná okrajová 
podmienka. Ak to tak nie je, tak je to tu potrebné zmeniť, kliknutím a  vybratím správnej. Čiže inlet – 
velocity inlet, outlet – pressure outlet, wall. Okrem definovaných okrajových podmienok sa nám 
objavila ďalšia okrajová podmienka, ktorá vyjadruje interiér.  
Klikneme na inlet a stlačíme Edit....  Otvorí sa okno Velocity Inlet. Klikneme na roletové menu pri 
Velocity Specification Method a ponecháme Magnitude, Normal to Boundary. Do okna Velocity 
Magnitude (m/s) napíšeme 3. Supersonic/Initial Gauge Pressure (pascal) sa nás netýka, pretože 
neriešime stlačiteľnosť. V sekcii Turbulence je potrebné nastaviť Specification Method. Klikneme na 
rolovacie menu a vyberieme Intensity and Hydraulic Diameter. Intenzitu turbulencie pri modelovaní 
prúdenia v potrubí môžeme ponechať 5%. Hydraulic diameter (hydraulický priemer) pri 3D simuláciách, 
sa určí výpočtom zo vzorca  𝐷𝐻 = 4𝑆 𝑂⁄  (4x plocha vstupu/obvod). Rozmery vstupu (inlet) sú 0,3x1,5m. 
Z toho vyplýva že hydraulický priemer je 1. (𝐷𝐻 = 4.0,3.1,5 (0,3 + 1,5) = 1⁄ ). Okrajovú podmienku 
rýchlostného vstupu máme nastavenú, klikneme tlačidlo OK.  
Klikneme na outlet a stlačíme Edit....  V sekcii Turbulence je takisto potrebné nastaviť Specification 
Method. Klikneme na rolovacie menu a vyberieme Intensity and Hydraulic Diameter.  



Zadáme hodnoty: Backflow Turbulent Intensity 5% a Backflow Hydraulic diameter určíme výpočtom. 
Rozmery výstupu (outlet) sú 0,5x1,5m. Z toho vyplýva že hydraulický priemer je 1,5. (𝐷𝐻 =
4.0,5.1,5 (0,5 + 1,5) = 2⁄ ).  OK. Položku Dynamic Mesh nebudeme nastavovať ani v Reference Values 
nepotrebujeme nič meniť. 
Pod Solution klikneme na Solution Methods. Nastavenia sú nasledovné. Pressure Velocity Coupling: 
Scheme – SIMPLE, Spatial Discretization: Gradient – Least Squares Cell Based, Pressure – Second Order, 
Momentum – Second Order Upwind, Turbulent Kinetic Energy – Second Order Upwind, Specific 
Dissipation Rate – Second Order Upwind.  
Na položke Solution Controls nenastavujeme nič. Klikneme na Monitors, nastavíme sa v okne Residuals, 
Statistic and Force Monitors na Residuals – Print, Plot a klikneme na tlačidlo Edit.  Otvorí sa okno 
Residuals Monitor, kde ponecháme zaškrtnuté Print to Console a Plot a v rolovacom okne Convergence 
Criterion nastavíme none. Nastavíme sa na Solution Initialization a klikneme na tlačidlo Initialize. 
Klikneme na položku Run Calculation a v okne Number of Iterations nastavíme predpokladaný počet 
iterácií napr. 500 a klikneme na tlačidlo Calculate.  Po ukončení výpočtu sa pozrime výsledky. 
 

Postprocessing (vyhodnotenie) numerickej simulácie 3D oblasti s rozšírením  
Hlavne v prípadoch zložitých priestorových 3D výpočtových oblastí je dôležité vytvoriť zodpovedajúce 
entity, a to hlavne plochy alebo hrany, v ktorých je možné následne vyhodnocovať žiadané veličiny 
(tlak, rýchlosť, hustota, teplota, turbulentné veličiny, hmotnostný zlomok, atď...). V prípadoch riešenia 
časovo závislých úloh je často žiadúce vyhodnocovať napr. priebeh rýchlosti v  určitom mieste, a teda 
je nutné vytvoriť zodpovedajúci bod vo výpočtovej oblasti, a  pomocou neho definovať záznam 
príslušnej veličiny v čase (tzn. monitorovanie veličiny, ktorá sa bude meniť s časom). V našom príklade 
definujeme dva rezy (Rez 1, Rez 2), v ktorých následne budeme vyhodnocovať príslušné veličiny, viď. 
Obr.XXX 

 

 

 
Rez zadefinujem tak, že definujeme roviny v smeroch súradnicových osí x, y, z v ľubovoľnej vzdialenosti 
cez celú výpočtovú oblasť. Okrem toho je možné definovať aj rovinu napr. 3 bodmi, alebo rovnobežne 
s jednou z hraníc v definovanej vzdialenosti. V našom prípade použijeme príkaz y z menu Surface >Iso-
Surface.  Z prvého roletového menu v okne Surface of Constant vyberieme Mesh... Z druhého 
roletového menu Z-coordinate. Klikneme na tlačidlo Compute a vidíme že minimálna hodnota Z je -
0,75 m a maximálna 0,75 m. Z toho vyplýva že rovina vedená pozdĺžne stredom kanála je na úrovni Z 0 

        

  

  

    

  

  

Rez 1 -  pozdĺžny rez vedený 
stredom oblasti    

      

Rez 2 – priečny rez vedený 1,3 
m od vstupu do oblasti (0,3 m 
za rozšírením) 
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m. Do okna Iso-Values napíšeme (resp. ponecháme) 0. Do okna New Surface Name napíšeme rez1. 
Príkazom Create sa rez1 vytvorí, a pomocou príkazu Manage môžeme Rez1 odstrániť alebo 
premenovať, alebo zlúčiť s inou plochou.   

 
 

 

Obdobným spôsobom vytvoríme rez 2. Rovina rez 2, má byť 1,3 m za plochou vstupu (velocity inlet) 
v kolmá na os X. Z roletového menu vyberieme X-coordinate. Klikneme na tlačidlo Compute a vidíme 
že minimálna hodnota X je -1 m a maximálna 4 m. Do okna Iso-Values napíšeme 0,3. Do okna New 
Surface Name napíšeme rez2. Kliknutím na tlačidlo Create vytvoríme rez2. K zobrazeniu vytvorených 
rezov,  použijeme príkaz z menu Display> Mesh. 

 
 

 

Zobrazíme si distribúciu rýchlosti pomocou izoplôch v rezoch. Pod položkou Results sa nastavíme na 
Graphics and Animations a v okne Graphics na Contours, Set Up...  Zaškrtneme  
Filled a v položke Contours of ponecháme Velocity a X velocity. V okne Surfaces vyberieme rez1 a rez2. 
Klikneme na tlačidlo Display. Zobrazí sa nasledovný obrázok.  



 
 

 

Z obrázku je viditeľné že za schodom je zavírenie. Oblasti modrou farbou majú záporné hodnoty 
rýchlosti v smere osi X, čiže  poukazujú na spätné prúdenie. Výraznejš ie ja v rohoch kanála. Možností 
rôznych zobrazení je veľa a ich voľba závisí od toho, čo chceme vyjadriť. Napr. ak by sme chceli zobraziť 
v kanále oblasť zavírenia resp. spätného prúdenia, zobrazíme si oblasť kde je X-ová rýchlosť záporná. 
Tentokrát v okne Surfaces vyberieme interior.  

 
 

Vyškrtneme Auto Range a do oknam Max napíšeme 0. Zaškrtneme Draw Mesh a  v okne Surfaces 
vyberieme inlet a outlet. Klikneme na Display, Close a Display v okne Contours. Po priblížení a natočení 
sa zobrazí nasledovný obrázok.      

 

 
 

 

 


